
What’s new (v3.4)? 
 
More formats 
Ardour, Tracktion & CMX 3600, 3400, 340 EDL & other  
CMX’like files (eg Grass Valley 4 &7 & Cudos) 
 
You can now specify a Reaper RPP as a session ‘template’ to be used when converting to Reaper 
format. 
Samplitude EDL, you can now choose to offset all clips by the Offset amount in the source session. 
Extracted OMF info, media files & session data can be written back to the OMF source folder. 
Much more detail is extracted from PT5 sessions, eg BPM, Beat markers, lists of Fx & plug-in’s 
used; now listed in for example the Reaper notes section. 
 
Recombine split stereo (.L&.R) files from for example, ProTools, to a sub folder called ‘Stereo’. 
 
Pro Tools import & Export has been enhanced considerably. Eg mute envelopes now fully 
supported. (both read & write) 
 
You no longer need to “unhide” hidden PT5 files originated on a Mac, AATranslator can now “see” 
any pt5 files whether hidden or not. 
PT5 export, can use either Clip or track/timeline based automation envelopes from all of the far 
more capable source formats, that include both of these types of automation.. 
 
There is now a Mac OSX export function for PT5 sessions. 
 
The notes have been substantially re-written, much clearer & even more vital to read. 
 
Note if Pro Tools (now known as, Avid Audio) is important to you, do read the notes. PT does have 
very specific requirements that are far more strict than any other DAW. PT can work really well, but 
it’s a very picky DAW, so make sure you deliver what it requires, this is very very important. 
 
A Tab Delimited Txt file export of all media files in a session, is included for advanced data 
processing or just as a printout.  
 
 
  
Quick guide vers 3.4 
Most options will be set automatically, when the info needed by the Destination format is contained 
in the Source format. 
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Select drive and the folder containing the project or 
session to convert from. The Source Format 

Select type (extension) of the file 
to convert from. Note; for Adobe 
Audition XML  Apple FCP, 
Steinberg track archive or Vegas 
Script, the “Extension” is XML 

 Film/Video Frames Per Second; Used when this information is not in the Source file 
IE [Audition XML, Steinberg Track Archive XML, Capture, Adobe/Syntrillium SES, 
Samplitude EDL, CMX-EDL, Vegas TXT, or Ardour] And the Destination format 
needs fps data [ADL, Apple FCP, Pro Tools, Reaper RPP, Vegas XML or Open TL] 

 PT5 Read only; Used for fps rates not theoretically available in PT5 format like 23.976 
that you can set in “FPS box”. Note this only effects the time “ruler” including offsets, not how well the 
clips are positioned. 

 



Used when Source is Tracktion, Vegas Txt or CMX-edl. 
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Used when Destination format is Open TL, PT5, Vegas XML or FCP-XML And Source format 
is [Audition XML, Steinberg Track Archive XML, Capture, Adobe/Syntrillium SES, Samplitude 
EDL, Vegas TXT, Tracktion, Ardour or CMX-EDL. Most Daws can use audio files with any, or 
even mixed bit depths. 

Suggestion; make copies if sending a conversion to someone else.  
Don't if you just want to swap between programs on the one machine. This option must be used 
if you want to extract files from an OMF, or to convert SD2 files to wav’s. 

 Makes Pro-Tools friendly dual Mono (.L&.R) files from standard Stereo 
Interleaved Wav files. It is selected automatically if the destination session is PT5 (& you have 
Generate File Copies On).  
It’s an option if going to Open TL, Sam-EDL or ADL. 

 By default if you want any copies including splitting stereo to mono and the 
files already exist in the location selected, then AATranslator doesn’t waste time overwriting 
what is already there. This option changes that and allows you replace the media files on disk 
with new copies. 

 Most people don’t want a load of empty tracks.  But if you do (for example if 
you have pre-labelled some tracks for later overdubs) this option allows you to do that. 

 This option strips out timeline Pan & Volume information and deals with the 
reversed panning in Reaper compared to Samplitude. At present, Reaper doesn’t support Pan 
or Volume envelopes/curves or level automation with an EDL import.  They use this part of the 
EDL to give an overall track volume gain/loss and give static track based panning.  

 Compatibility option for users of old software, eg EDL Convert.  
If this item is unticked, AATranslator outputs in v1.6 (it reads all Samplitude EDL’s up to v1.7) 

 PT5 Read only Cures a very rare problem that tracks are sometimes read 
in reverse order.  

 PT5 Read only Takes the sample rate embedded  in a PT session 
and sets the destination format to twice that rate. (see PT notes, for more details) 

 PT5 Read only Hides alternate playlists, hidden and inactive tracks.    
 PT5 Write only  will create a pair of files, one the same as a standard 

AATranslator PC compatible file & a 2nd file starting ._  You will need both of these files for use 
with MAC OSX. (see PT notes, for more details) 

 PT5 Write only when selected clip volume & pan info will be converted 
to PT timeline automation. If not selected the original sessions’ timeline automation will be used

 EDL write only when selected blank space the length of the original 
session offset is inserted before the 1st event.  

We have 6 XML based Export formats available, select which one you 
want here.       See “XML Sessions” for more details 

 

 



Vegas XML files contain information about any layered takes. An 
XML import into Vegas 9 will only put the top take on the time-line, 
though the rest of the takes will be in the “pool”. 
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Import Logic XML; To 
convert from a Logic Pro 
Apple- FCP-XML, tick this 
option 

 

Ignore Vegas Inactive Takes; is very similar; it filters out all non-
played takes in an AATranslator conversion. Not all destination 
formats allow overlapped takes so for them this is the best option. 
Mute Vegas Inactive Takes will only be usable where the 
destination format can handle overlapped takes and clip mutes.  

Leave all these ticked unless you have compatibility problems. [Eg switch off Pan 
List, if creating an ADL for AV-Transfer to read] Many DAW’s & conversion programs use 
out of date versions of a given “standard”.  In theory if a DAW/ app  doesn’t 
understand a particular chunk of info, it should just ignore it. But clearly this 
“good practice” is not true in practice. If a host App complains, then these options 
allow you to remove what may be causing it grief. 

Select the type of file you want to create, the Destination format.  To select which of the 6 
different XML based types we support, use the “XML Output” drop-down box 1st 

 If you are converting to a Reaper 
RPP session it is possible to use a template, to store aspects like Routing, plug-ins, custom 
skins, in fact anything including tracks with media if you wish.  
Where there is a conflict say you want to convert a 44.1kHz PT session & your RPP template is 
48k the new RPP session will be 44.1kHz. In the unlikely event your “Template” has audio in it, 
Reaper will just real-time sample rate convert it to be the same as the PT source session.  
Currently this template capability is only available if going to Reaper RPP format.

If converting from OMF, (only), it’s possible to store your new 
conversion, including media extracted, in the OMF  Source folder.

Otherwise: you will Browse for, or create, a new folder via the open 
icon,  . This is where your new session file will go as well as any 
copied / split or re-combined (2x mono → stereo) media files. 

The Media Files Tab lets you see if all the files can be located.   

 A tick means AATranslator can find the files required. 
Tip; If the Audio Files Tab shows files can't be found at say E\AATranslator\........ then use "A 
Selected folder" option & point to E:\AATranslator\    
The same method can be used if you see a "Volume Name" Eg Big_Disk\ rather than say, D:\ 

 
Click to export a list of the source media as a Tab separated Txt file. It 
is automatically saved to “Send Output to…”  location 
When you are happy you have selected the options you need, click 
“Generate Output” 

 



F
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ile Menu; You can look at and if you wish, edit the output of 
your most recent conversion.  
But only if it is a text based type. Eg ADL, Vegas Txt or 
Samplitude EDL. 
The Append function is accessed from here too. 

  
Click on “Append Session Files” in the 

Append Session Files  File menu and this screen pops up.  
You can combine any 2 files with a file 
extension listed in “File Types”.  
Click on the boxes or select All, None or 
Invert. In the example on the left Invert 
would select all file types except XML & 
TXT. 
Note: the Session output format will be 
the same as the 1st file you select. The 
appended session will also inherit the 
1st file’s Sample rate etc.  
As usual, for a format like Vegas TXT 
that does not contain sample rate or 
FPS info these will be as you have set 
them on the main page.  
(If you select a Vegas Txt file as your 1st file)

 
Notes 
Where options are not relevant to a given source and destination format combination, they will be 
“Greyed Out” 
Context help tips are available by hovering your mouse over any option button or box. 
 
Important Note: Media files will be left unmodified when converting from one format to another 
(apart from options to convert SD2 files to wav’s and splitting Stereo to 2x Mono files) but in any case, we do not 
change aspects like Bit & Sample rate. Or the Metadata within the files. And with video media we 
never modify the source files.  
 
So the readability of media files by the destination program is down to you the user’s knowledge of 
the requirements and capabilities of the host.  
There are further notes to help with these compatibility aspects.  
 
We often allow the possibility to create output sessions that deviate from a supposed “standard”. 
The reason is because in practice most Audio & Video editing software deviates massively in their 
implementation of any “standard”.  
This freedom allows you for example to have stereo files in an Open TL session that Logic can 
read just fine and will be way more convenient than having to deal with stereo as pairs of mono 
files in Logic.  
The downside of this freedom is that a TL conversion that works great in Logic will not work at all 
on a Tascam  MX2424 HD recorder. 
 
Lexicon; The words used in these documents and equivalent words used by various DAW & NLE 
manufacturers. 
Words, as 

we use 
them 

generally 

Equivalent names Meaning used by others 

 



Session File that contains  "instructions" how media is 
used on the timeline 

Project, Song, Composition, 
Arrangement, Sequence 

Clip Piece of Media on the timeline;  Region, segment, object, item, subclip, 
media event  this maybe a selected part of a file 

or a whole file Master clip, whole file region 

Event Clip, marker, automation point on timeline 
Clip 
Automation 

Fades, Eq, level, pan, Mute (& any DSP based alteration) information (meta 
data) attached to a clip. 

Media Audio or video data (potentially MIDI, text, still 
images) 

Assets, Essence, raw data  

Timeline Events, clips placed on a track at specific time positions  
Timeline 
Automation 

Envelopes or value changes, that occur at 
specific time points with no regard to any clips 

 

Point Envelope point in time indicating a specific 
value of a dynamically changing quantity 

Keypoint, keyframe, automation 
point, bezier point 

OMF 
Embedded 

Session where the "instructions" & the media 
are all in 1 file 

Export all to one File, 
Encapsulated, 

OMF 
Referenced 

The omf has "instructions" as to how to use 
media external to the omf 

External, Ref, Referenced, 
Separate Audio, Linked 

Envelope A value that goes up & down, over time (typical 
values are volume & pan) 

ADSR, Curve, dynamic 
automation,  

Dynamic A value (like volume) that goes up & down, over 
time 

Automation, 
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ProTools, pt5  
We have added PT5 capabilities because of it’s ability as an interchange 
format 
it offers far more than the widely used OMF2 format can do. And for ProTools to have OMF capability 
you have to buy DV toolkit at over $700, or just Digitranslator 2 at about $500.  
 
Capability Example: PT to Reaper 
Notes: codes used below. 
~ = not available with this format. Note 2; all features except Session Bit Depth are supported by 
the Reaper RPP format and are implemented in AATranslator. 
no = potentially available but not implemented 
** = Fades are rendered. So no information to pass to Reaper (or any other format) 
Yes-! = It is possible (though hard) to create an “illegal” pt5 containing stereo files, which can be 
read by Pro-Convert & AATranslator. But not by Pro-Tools. 
? = don’t know yet, but probably not supported 
 
Pro Tools session conversion to & from Reaper; using AATranslator v3.4 
Extra Conversion software needed 
to export/ import from Pro Tools → 

Digi 
Translator 2

Digi 
Translator 1 OMF Tool AATranslator 

Interchange/Session Type used → OMF2 OMF2 OMF2 PT5 
Track Name no no no yes 
 Pan no no no yes 
 Solo no no no yes 
 Mute no no no yes 
 Volume no no no yes  
TimeLine Pan envelope ~ ~ ~ yes 
 Vol envelope ~ ~ ~ yes 
 Mute envelope ~ ~ ~ yes 
Clip / Region Mute no no no ~ 
 Fade Render **  ?  ? 6 fade types 
 X Fade Render **  ?  ? yes 
 Pan no no no ~ 
 Pan Envelope no no no ~ 
 Gain no no no ~ 

yes, unless in 
Avid NLE 
compatible 
Frame edit 
mode 

Volume 
Envelope  no no ~ 
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Session Markers no no no 
absolute, 
beat, region 

 Video import only no no yes 
 Stereo Files no no no Yes-! 
 Tempo (bpm) ~ ~ ~ yes 
Session contains Sample rate yes yes yes yes 
 fps yes yes yes yes 
 bits yes yes yes yes 
 Start Offset yes  ? ?  yes 
omf only. Referenced, Embedded 
or Both 

R, (till PT 6.9)
B (pt7&8) R R ~ 

Features -Limitations -Notes 
Track names 
Dropped, Avid 
DV x'press not 
readable

Mac OS9, 
16 bit only 

Mac OS9, 
16 bit only

markers read 
only for PT 

 
After much testing we believe the above is true, if you have information to the contrary, please let us know.  

 

mailto:it@s


 
Exporting PT5 files for use in AATranslator 
AATranslator can make a reasonable job of converting any pt5 file, (worst case the result will likely 
contain more from the original Session than going the OMF route) but for best results you should be 
prepared to “save as” a vers of your Pt 5.1 till 8.04 session best suited or tweaked for PT5 
capabilities.  
 
PT5 file capabilities 
Pro Tools version 5 had no Stereo Track type and the maximum session sample rate was 48kHz.  
 
In theory pt5 exports from later versions will have these same limitations too, but in reality most of 
these newer, pt5’s have considerably more information contained than Pro Tools version 5 ever 
had.  

What you should do, to get a GOOD pt5 export  
Very Important; for AATranslator to read the Automation on a Stereo track use the “Split 
Selected Tracks into Mono” command in the PT File menu. (this is applicable to greater than 2 
channel tracks too, eg LCR, quad & 5.1, etc) 
 
Region Groups and Region Loops {Highlight all regions & use Unloop command in the Region 
menu and "flatten" regions} 
 
Elastic Audio (thanks to Bill Blue for researching and writing this section and  contributing to other sections too) 
Any work you have done that changes track timing will be lost, but you will get the track as it was 
before Elastic Audio had been added. 
If you want to preserve timing changes achieved in PT, first transform them to the XForm mode 
(which is not real time like rhythmic, monophonic and polyphonic modes are), then after the 
transformation to XForm, commit  the changes to the original track.  If you were to commit from 
one of the real time modes, it will still work, but with varying degrees of artefacts from ok to bad 
depending on the track content.  E.g., a  bass track maybe ok in monophonic EA mode, rhythm 
instruments (except cymbals) do pretty well in rhythmic, vocals can do well in monophonic too.  But 
guitars, especially acoustic, are pretty bad in any real time mode.  The only problem with XForm is 
that it takes about 10 minutes to render a 3 minute track, and sometimes when you commit it, PT 
will render it again(!)  So this step can be tedious but the results are good. 
 
Inactive tracks will not be exported (in theory), {if you want them included make them active, 
assuming enough “voices”. If not, do 2 saves using different track sets}. 
 
Anyway even “Inactive tracks” will still be references to the media used & AATranslator will find & 
place these orphaned, or not fully defined tracks after the main tracks on a conversion. These 
tracks will be muted and “-Unused” will be appended to the track names.  
 
Hidden but active tracks and alternate Playlists will also become visible once translated. 
MIDI tracks with their original names will also appear but not the MIDI data. 
 
To export MIDI data from PT,  select Export Midi > to a .mid file type 0. The PT session tempo is 
read by AATranslator and for many destination formats, Eg Reaper, the starting session tempo is 
set. 
If you don’t want to have all this extra info transfer across to your destination format; then remove 
alternate playlists, hidden and inactive tracks, MIDI etc, then “save as” before doing a pt5 export.  
 
Other considerations (many re exporting from a Mac) 
Important: any filename more than 31 (for some pt versions 33) characters total or 27 char + 3 
char extension will be truncated. {Fix, trim all file names inside PT to be 27 char or less.  
 
Saving a pt5 Export in Mac OSX: Important  
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We strongly suggest you make a new folder to contain your pt5 export(s), then zip the whole folder 
straight to whatever removable media you are using. This is the safest way to guarantee the Mac 
Fork data will be readable on a PC. Note it is also possible to use a network connection or if you 
have a program like “MacOpen” on your PC, you can use Apple HFS+ formatted disks. 
 
To Export to pt5 format; File > Save Session Copy in > Save as Type, choose PT5. 
 
Do not change “Session Parameters” apart from adding Mac/PC compatibility & Audio File type = 
wav, if possible.  
Optional extra settings: Depending if you are exporting from a PC or a Mac different options will be greyed 
out (not available). No matter, these are mostly bloat reduction suggestions.  
 
Items to copy; Only Audio files & Movie/Video if used are needed, un-tick all the rest. If exporting 
from a PC choose Wav files, on a Mac you have no choice, but no matter AATranslator 
understands SD2 files.  
 
File name; the suggested name will be “Copy of your orig filename.PT5”,  you are free to change 
this if you wish.   
Suggestion; delete “Copy of” it serves no good purpose. (the fact your original will have either a 
.ptf or less likely, a .pts file extension, will make it different & unique compared to a .pt5 file). And 
Digidesign/Avid make you adhere to the old 27 char limit of OS9, so you may not want to waste 8 
of the available characters. 

In the event you hit export problems 
To be through, check your pt5 export is good by opening it in PT.  
Open/load the pt5 via the file menu, (drag & drop or just clicking on a pt5 to launch PT is known not 
to work on some rare occasions, with pt5 files). If PT can’t load it’s own pt5, or the result is not 
what you expect, try closing then re-opening PT and try again.  
 
Limitations; We have found, the info retained in a pt5 export, will depend on the PT version, & if it’s 
from LE, TDM or M-Powered & the Pt hardware used and also if the host machine is a Mac or a 
PC. This means there are an awful lot of possible variations and we have only tested about 15 of 
these, from LE, TDM and M-Powered, using Vers 6, 7 & 8. We have programmed in adjustments 
for some of the variations we have found but there are an awful lot of possible variations we may 
not know about (yet).  
 
Don’t use “illegal” characters like / : \ in a filename. Note “\”  to Mac OS, is just another character, 
like a-z, but to a PC, it has a very special meaning, so if you are using a Mac don’t use this 
character! 
It is also recommended you avoid non-American characters like é ü î £ € etc.  
If you plan to convert to Apple XML it is further recommended you avoid [ ] { } . , (  ) | < > ! * ? ; “ ‘ & 
^ # 
 
For ultra high compatible naming, which really should not be necessary, just use  a-z 0-9 _  with no 
spaces, a mixture of upper & lowercase is fine and should improve readability.  
 
As track names will be used to name audio files recorded, bounced or rendered in PT you should 
limit the tracks names too.   
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Importing PT5’s. General Options, see later for Mac, exceptions  

 ← Select drive & folder containing PT 
session to import from. Then select the PT5 
tab  and Source pt5 session   ↓ 

  
 
Select one of these 

 
There are 6 XML based output formats available, select the one you want via this drop down.  

   
And choose the location where you want the new session file & any copied media to be stored. 
 
If you are converting to a Reaper RPP session it is possible to use a template, to store aspects like 
Routing, plug-ins, custom skins in fact anything including tracks with media if you wish.  
Where there is a conflict say you want to convert a 44.1kHz PT session & your RPP template is 
48k the new session will be 44.1kHz. In the unlikely event your “Template” has audio in it, Reaper 
will just real-time sample rate convert it to be the same as the PT source session.  
Currently this template capability is only available if going to Reaper RPP format. 

 
More info coming up about where you source the Audio & Video media from. The option selected 
here is the most common though.  
 

don’tFPS; If you 
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 tick the “Override (PT5)” box, the fps info embedded 
within a pt5 file will be used automatically.  
But the pt5 format does not include the 23.976 fps frame rate, any pt5 

exports from later vers of PT that use this will be labelled (incorrectly) as 24fps, the “override 
(PT5)” option gets round this limitation. 
  
This is only really relevant if you are using video with an hh mm ss ff ruler or you want to use 
Timecode to an external device. Note you can force the fps output to a number of other rates too, 
treat this powerful capability with caution! 
Other options you may need to set for a conversion from a PT session to an output format of your 
choice are shown here. Any options not relevant to PT & your chosen destination format will be 
“greyed out”.  Eg the Reaper & Samplitude options will become “active” if Sam EDL was your 
destination format. Likewise if you want to create a Mac OSX readable pt5 session from a PC pt5 

 



session, the Mac OSX PT Output option will be available. 
 
Sample Rate & Bit Depth; these are greyed out because this info 

at. 

d 
 
 

ill be 

place 

verwrite Existing Files; By default if you choose to copy media and 
the files already exist in the 

 

ost people don’t want a load of empty tracks.  But if you do (for example if 

 with the 

 

embedded in a PT5 file is always used when PT is the source form
Generate File Copies; Note if you make copies, AATranslator will 
make standard stereo interleaved files from pairs of .L &.R files an
place these in a folder called “Stereo”. But these will not be placed in
the destination session, the reason being PT can have totally different
Panning, Volume and Mute automation on the 2 halves of a stereo 
track and it is impossible to auto-merge this data to be valid for a 
single stereo file. So to preserve all the automation 2 mono files w
placed in the destination DAW. If as is often the case 1 set of 
automation can be made valid for a stereo track/file you can re
the 2 mono files with 1 stereo one, then delete the redundant track. 
 
O
location selected, then AATranslator doesn’t waste time overwriting 

what is already there. This option changes that and allows you replace the audio & video files on
disk with new copies. 
Show Empty Tracks; M
you have pre-labelled some tracks for later overdubs) this option allows you to do that. 
Reaper EDL Output; This option strips out timeline Pan & Volume information and deals
reversed panning in Reaper compared to Samplitude. At present, Reaper doesn’t support Pan or 
Volume envelopes/curves or level automation within an EDL import.  They use this part of the EDL
to give an overall track volume gain/loss and give static track based panning. 
Samplitude v1.5 Output; Option for users of old software, eg EDL Convert.  
If this item is un-ticked, output is v1.6 (AATranslator reads all Samplitude EDL’s inc v1.7) 

it, we used to 

ride; This takes the sample rate embedded  in a PT session and sets the 

rsions of PT that support a max of 48k Pt5 exports 

 will be sample rate 

2) s to the 

3) Translator 

Reverse PT Track Order; this is a “legacy feature” so you probably won’t need to use 
have problems with a very few PT5’s in that original tracks 1-9 would display as 9-1 after an 
AATranslator conversion. 
PT5 Sample Rate x2 Over
destination format to twice that rate.  
How to use high sample rates for ve
(an example using a 96k PT session originated on a PC & using Wav files) 

1) Export your 96k session in Pt5 format as a 48k session (the 96k files
converted to 48k). 
You will need acces
original 96k files later 
Open the pt5 file in AA
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and select PT5 Sample Rate x2 
Override.  
Use the “A 4) Selected Folder” 

e loc
 

 the PT5 file were made on a Mac you will need to take account of the following:- 
the session will 

 in selected PT5 file” and get 

e files AATranslator converted are 48k, so you will want to replace them with the 96k 
 the 

onverted files you can overwrite them by copying your 96k 

option as shown and select th ation of the 96k files  

 
If
The sample rate converted files PT makes, will be SD2 files & all references within 
be to SD2 files. The original 96k files will be either Wav or possibly AIFF. If they are AIFF convert 
them to Wav, Wav is the current PT recommendation in any case. 
So follow steps 1-3 as above, then select “original paths embedded
AATranslator to convert the SD2’s to Wav files and make a new 96k session that refers to Wav 
files. 
But th
originals. For all destination formats, bar Open TL, AATranslator places the media straight in
“Send To” location you have selected.  
If you don’t want to keep the 48k down-c

 



files to their location. Or to keep, move the 48k wav’s to somewhere safe.  
Hide PT Unused Tracks; Hides alternate playlists, hidden and inactive tracks.    

Translator PC 

xport to PT5 section) 

is the one to find and run. 

 how they are arranged in PT8.0.0 

MAC OSX PT5 Output; will create a pair of files, one the same as a standard AA
compatible file & a 2nd file starting ._ 
You will need both of these files for use on MAC OSX. (more info in the E

porting a PT5 (Exported from a Mac) 
t with the characters ._ this 

 
Im
There will be a pair of .pt5 files one will star
The way the various files and folders are organised varies a lot between different version of Pro 
Tools. 
Here is

 
The file shown here called “Copy of 4clip3MonoTr.pt5” is zero bytes long [this is useful  in Mac 
OSX, but is useless to Windows] but if such a file is in the same folder as the wanted file, 
._xxxx.pt5,  AATranslator will run the file it needs.  
 
The folder “Renamed Audio Files” contains SD2 format Audio files. Later you will need to “tell” 

ut here is an example from Mac PT8.0.4 

AATranslator this is where the audio is located. There may also be a Fades folder, which is not 
required by AATranslator, and a Video folder, which is. 
 
B
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The “wanted” pt5 file is accessed via the folder called __MACOSX. But nothing 
 else in this folder is of any use at all to a PC {there maybe other sub-folders called “Fades”, 

 also 

(it 

 

“Video” etc, all of them
of no use to a PC}. Likewise 
the 2nd instance of “Gerrit 
Mac” is of no use to a PC, 
is zero Bytes in length). But 
the wanted SD2 Audio is to
be found in it’s sub-folder.  

 
here are a few variants of these 2 layouts; but to re-cap what AATranslator needs is 

 in the same folder

T
A .pt5 file starting with “._” {and this may well be accessed via a folder called __MACOSX} 
A folder of .SD2 audio files that do NOT start with “._” 
In any instance where there are a pair of ._ & plain files  you can click on either 

 to be as they were in PT8.0.  
 re-link to 

hen “Generate Output”. This will 
 SD2 

If you had chosen “Look for Source Files 

) This box will appear when you click 

of these and AATranslator will know which one to use. 
If you were to re arrange the files as they are in PT8.0.4
A Mac running Ver8.0.4 will be able to open the session just fine. Well you may have to
the audio files. 
 
Choose your output format, Select “Generate File Copies” t
convert the SD2 files to Wav’s (In the very unlikely event you want the audio files to remain in
format, don’t click on “Generate File Copies”.) .  
 

in….Original Location”:-  
 
1
 Generate Output 
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Clicking “Yes” will take you straight to the location of 

) Select the audio folder which probably will be 

Important 
e simple but VERY Specific requirements, all files must be:-

your PT5. 
 
2
close by, in the case of Ex PT8.0.0 files it will be 
called “Renamed Audio Files”  
  

 
3) The SD2 files will be converted to WAV,s and 

te 

 copied/converted files will go to 

 at stage (1) you had clicked “no” meaning use 
u 

xport to PT5 using AATranslator 

you will see this information box. Note the FPS ra
shown will be that in the original session file and 
not a forced “Override (PT5)” rate if you were to 
use that option.    
Note as always the
the “Send output to…” location you have previously 
selected. 
 
If
existing “Selected Folder” Location, then when yo
click on Generate Output you will go straight to 
this “Details” box. 
 
 
 
E

PT has som  

t do this for you) 

nd “Export to… Pro Tools PT5”. The settings and options you may

1) mono (AATranslator will convert any stereo PCM wav files) 
2) either all 16bit or all 24bit  (you must check, AATranslator will no
3) all the same Sample Rate (you must check, AATranslator will not do this for you) 
 

Select source session, a  need to 

PS; will be read from the source session, where available. But you 

 

ere available. 

e. 

set are the ones shown below, that are not “greyed out”. 
 
F
will need to set this if coming from:- Audition XML, Steinberg Track 
Archive XML, Capture, Adobe/Syntrillium SES, Samplitude EDL, 
Vegas TXT, Ardour. A few OMF’s don’t carry fps data either, but a
pop-up info box will let you know when this happens. 
Sample Rate; will be read from the source session, wh
You will need to set this if coming from:- Tracktion or Vegas TXT. 
Note all files in a PT session must have the same sample rat
AATranslator does Not sample rate convert files. 
Bit Depth: Note all files used in a PT session must have the 

s 
es 

same Bit depth, either 16 or 24bit. (the32bit setting is for other 
destination session formats). Beware PT is the only DAW with thi
limitation, all other Daw’s allow multiple bit rates. AATranslator do
Not convert the Bit depth of source files. You will need to select a 
(single) bit depth if coming from:-  Audition XML, Steinberg Track 
Archive XML, Capture, Adobe/Syntrillium SES, Samplitude EDL, 
Vegas TXT, Tracktion, or Ardour. 
Generate File Copies; this is the best option to use as standard 

for a number of reasons. 
eo original) option is engaged automatically when 

practice,  

Eg: the Convert Stereo to Mono (and copy ster

 



you generate file copies, all “Linear PCM”, Wav stereo files will be split to 2 mono files.  
If you don’t “copy”, all stereo files will remain stereo, thus you will create an “illegal” PT5 file that PT 

PT session Must, All be,
can’t open! 
All files in a  either 16bit or 24bit, and “Linear PCM”, a mixture of AIF’s & 

ption to, 
 

bit float files, which are superior to what PT can handle, you would be very 

at is it allows volume values way above the max a 
dB 

les; By default if you choose to copy media and the files already exist in the 

 
need) 

mply save straight to the removable media you will use on the Mac. 

ied.    

Wav’s is fine but no compressed Aiff or Wav files or MP3’s, WMA, Apple lossless  etc.  
If you know all files fit the PT requirements, fine, however if there are files PT takes exce
but the source app is happy with it is far better to have some copies to mess with, rather than your
precious original files. 
Eg most DAW’s use 32
ill advised to downgrade your original files.  
Digital nerd note; one aspect of a “float” form
Integer format can handle, with an integer format as PT uses, as soon as you try to go beyond 0
full scale the audio clips & becomes unrecoverably distorted. So a better option would be to have 
copies of these files, then “normalize” them to 0dB or a bit less, say -0.1dB, then batch convert to 
24bit integer. A great program to do this sort of job is Adobe Audition, though there are other apps 
that can do this too. 
Overwrite Existing Fi
location selected, then AATranslator doesn’t waste time overwriting what is already there. This 
option changes that and allows you replace the audio & video files on disk with new copies. 
MAC OSX PT5 Output; will create pair of files, (dual forked in Mac jargon) one the same as a
standard AATranslator PC compatible file & a 2nd file starting ._ (it contains “resource fork” info Macs 
You need both of these files for use on Mac OSX. Note the ._xxx.pt5 file is hidden so methods like 
drag and drop will miss the hidden file (unless your PC is set-up to see hidden files – see below if you 
want your PC to see hidden files). 
The recommended method is si
Or create a folder in your “Send Output to..” location. 
If you copy a folder all content visible or not will be cop
 

 
Many source session formats such as Reaper & Steinberg Track Archive can have both 

k) clip (region) based and Timeline based automation envelopes. PT only has timeline (trac
automation. If you Don’t select this option the original timeline auto’ will be converted to 
PT. Select the option, then only clip based automation gets converted. (see “Session 
capabilities searchable Table.xls”, for details of what data is supported by various Daw
session formats.) 
   

’s & 

-hiding  files in Win OS:- 
r {keyboard shortcut, Win/start +E} T

Un
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Step 1) open Windows Explore ools > Folder Options >View > 

pply to All Folders”, 

Video and PT5 
n contain a single video file placed at any point on the timeline. The whole file will 

sion, in a folder called “Video Files” 

ote a limitation with AATranslator V3.4 when writing a PT5 file and copying media, is that all the 

Video Notes 
Apple QuickTime is the native format for Apple Final Cut Pro (FCP) & very common for exports 

Hidden files and folders > then select/click  “Show hidden files and folders”.  
Step 2) If as is likely you may want to see hidden files on any disk, click on “A
the button is near the top of the Folder Options Pop up.  

A pt5 session ca
play there being no possibility to trim the start or end points.  
AATranslator will look for the video file specified in the PT ses
in the location of your pt5 file. 
 
N
media including video will be sent to the “Send Output to “ location. You may have to re-link to the 
single video file when you run your converted session. Or for most versions of PT you could create 
a folder called “Video Files” in the location of your pt5 file and move the video file to there.  

 



from Avid NLE systems and is the main technology used within Pro Tools and most video files 

PC 
r WMA. 

ese will require a suitable Codec and if the data is wrapped in a MOV “wrapper” and you are 

ese come with the Windows operating system, or get installed when a video aware program is 

f 

pple QT codec available.  Again many come with either the Mac OS or in Quick Time for 

ay more than 2% significant in Film/Video production). So realising this reality most of the latest 

ideo files into an AVI based format, that will likely run way better on a PC. 
 

c) 
own to low value is really not that important. 

ompletely, regardless of the fact that a lot of detail may not actually change from 1 frame to 

ompression systems like DivX say, work by fully 
re data to update what has changed between 

nd I suspect these notes are already too long for many to 

 or why isn’t a conversion from format “A” the same in format “B”? 
rams AATranslator is not perfect. 

exported from PT will be xx.Mov files.  
Essentially a QT “Movie” is a wrapper for a wide range of data types and this includes data with 
origins like an AVI & for audio, a Wav o
 
Generally video formats will use some form of Data Compression such as DV, mpeg-4, H.264, and 
th
using a PC the codecs will need to be specific QT codecs, IE none of the codecs available via the 
MS operating system will be usable in QT for Windows.  
 
An example; an AVI can in much the same way as a Mov use a wide variety of Codecs, many of 
th
installed on your PC and other Codecs can be downloaded for free & some more exotic types can 
be bought. So on a PC if you want to play an AVI, the Codec required is specified in the header o
the AVI file and if it is on your system the file will play.  
 
The same is true if an AVI is wrapped in a MOV wrapper, but now there will need to be a specific 
A
Windows, a free download from Apple. Microsoft offer free downloads of QT codecs for WMA 
(Windows Media Audio) and WMV (Windows Media Video) but other more exotic types like “Apple 
Pro-Res” will have to be bought. 
 
QT Mov support is clearly very important (Mac’s may be only 2% of the computer market but are 
w
versions of PC based DAW’s do support QT.  A slight downside is that QT for Windows performs 
significantly less well than QT on a Mac (which works rather well).  
 
Now if you have a very powerful PC this may not matter, if not it is probably worth converting the 
v
To do this one needs to buy the Apple QT Pro upgrade $29.99 in the USA, rather more in the UK,
but it enables the editing including export functions locked within the free QT player.   
 
Then having exported as an AVI you can then use PC specific codecs.  

here is a wonderful (and free) PC prog called Virtualdub, http:/www.virtualdub.org that can T
convert & modify AVI files to the best format for a PC based DAW.  
 
As to the “best format” the thing to bear in mind is for most users getting the data rate (IE bits/se
d
Most computers can shift a fair amount of data with little problem. What you probably want to avoid 
however, is very “clever” formats that may very well be able to deliver quite viewable images using 
a bad Internet connection but are so complex they take a big CPU hit.  
 
So for moving images with audio on a DAW, go for formats like DV that encode each frame 
c
another (IE in a 24th to a 30th of a second).  
 
“Clever” low bit rate but quite good looking c

ncoding a “key-frame” then only using some moe
frames. Great if you hit play then watch, but rather bad if you want to “spot” or tie sounds to a 
particular frame.   
 
Sorry but this is a complex subject a

ppreciate. a
 
Limitations,

1) Like all prog
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2) The way DAW’s & NLE’s handle essentially the same information varies so Massively, our 
 as possible. The downside of this is there 

 
Eg. Tra

roTools uses only mono files and in versions later than v5, place these in highly specific track 
ono, Stereo, 3track LCR, 4 track LCRS, 4 track L&R front + L&R Rear, and it 

 Daw’s do it this way.  
eaper has NO track types at all.  Any data can go on a track, Mono, Stereo or multi-channel/poly 

deo. You can mix data types on one track if you wish with any 

 mono and stereo files on one 
ck.  And has four track types, Audio, Video, MIDI and Busses. 

le issues. And poly or multi-
hannel files too. 

reo files stay as interleaved files and when imported into the timeline behave as 
 linked/grouped stereo pair, placed on a pair of tracks, so in many ways, appear very much like 

e panning, the lot.  

ro Tools is the underlying stereo file will 
e converted to a PT style .L&R mono files pair as is essential, but these will both appear twice, IE 

s different level, pan & fades on each (mono) half of a stereo file, and this 
ill also be read & applied to an AATranslator conversion to PT. 

ted tracks – please Mute/Delete 
hat is not wanted. [We would far rather have unwanted duplication than any omissions]. 

versions 
efore v6.4, 6dB’s. AATranslator passes on any gain adjustments in the original session unaltered. 

priority is to preserve as much vital information
maybe duplicated or seemingly redundant tracks & clips on a conversion.  

ck types 
P
type “wrappers”.  M
works well. 
 
But no other
R
audio up to 64 channels, MIDI or Vi
sample or bit rate, and use compressed formats like MP3, etc. 
  
Audition v3 is almost as liberal as this.  It can have a mixture of
tra
 
Sony Vegas has a very flexible way of dealing with mono/stereo fi
c
 
Two channel or ste
a
PT does with 2 mono “grouped” files.  
But L&R can be un-linked and then treated just as though they are 2 separate (mono) files. This 
includes separate time positions, volum
 
The way AATranslator deals with this, when converting to P
b
what “looked” like 2 mono tracks in Vegas will become 4 mono tracks in PT. Sorry there seems no 
way out of this, but the Vegas 2  “virtual” mono tracks will be panned hard L&R, and/or  have the 
correct Pan, Volume, mute etc automation applied to each half.  IE it will play exactly as per the 
Vegas original in PT.  
 
To repeat, Vegas allow
w
 
Sorry, but when converting to some formats there may be duplica
w
 
PT vers 6.4 & later allows for a maximum of 12dB of gain with the volume automation and 
b
The way amounts of gain in excess of 6dB will be handled when a PT5 file is imported into various 
later versions of ProTools & other PT5 aware software is very variable. You may need to trim the 
volume after you have imported the pt5.  Or if the conversion is rejected by PT modify the source 
session to have no gain greater than 6dB. 
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OMF to  your format of choice 
Important: If you have an “Embedded” omf you must select “Generate File Copies” if you want to 
extract the Audio (& Video)  within the OMF.  
 
If you don’t want to use the media “Embedded” in the OMF, then select “A Selected Folder” & 
choose the place where the Audio & Video you want to use is to be found. If as is likely you don’t 
want another copy of the files already on your system, then don’t have “Generate File Copies” 
selected.  
 
This ability to source session data & media from different locations is particularly useful where:- 
You have the audio on your system, but just need the latest “Version/edit” info. (this will save you 
time & disk space) 
You have “conditioned, tweaked or modified/improved versions of the original audio you want to 
use.  
Note:  the session data will always be drawn from the OMF file.  
 
The application specific information are recommendations,   

Avid (Digidesign) Pro Tools with DigiTranslator 2 Option 
Export  
Select the tracks you want to export 
File > Export >Selected Tracks as OMF/AAF 
OMFI/AAF Options:- 
Export as; OMF 2 
Enforce Avid Compatibility; do not select 
Quantize edits to frame boundaries;  only select if you want AATranslator to convert the OMF to 
“Final Cut Pro”. 
Note If this option is chosen you loose volume automation. 
  
Sample rate options; ignore (unless you have good reason not to) 
Audio Media Options:- 
Audio Format & Bit depth; leave as per the session, (unless you have good reason not to) 
 
Source media; you have 3 options 
1) Refer To Source Media: - or “Referenced” Creates an OMF file that  
refers to the original media.  
2) Copy From Source Media:-  Copies audio to another drive or folder.  
3) Consolidate From Source Media:- Copies only the part of the files that are actually used by the 
session. If this option is chosen the “Handle size” option is available. Suggest choose the max 
amount of 5000ms,  (5seconds). 
 
 
The following are not exported; video files, pan or mute automation, markers, MIDI or  plug-in info. 
Fades & cross fades become separate files, fade data is not written to the OMF.  
Pro Tools does export volume automation to OMF, but only if the Quantize edits to frames 
boundaries option (Avid Compatibility Mode) is off. If Avid Compatibility Mode is on you are limited 
to either 48kHz or 44.1kHz sample rate.  

Avid Media Composer; Adrenaline 
Export; Select range on timeline & the audio tracks to export. File > Export. Click “Options” in 
“Export as…” pop-up. 
Export Settings :  
Export As; OMF 2.0  
Include All Audio Tracks in Sequence; [tick]  
Export Method; Choose Consolidate and Embed Media  
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Target Drive for Consolidate; choose a drive 
Handle Length; enter a value of at least 100 frames   
Include Rendered Audio Effects; [tick] 
Convert Audio Sample Rate to; Project  [tick] 
Choose Convert Audio File Format to; WAVE  
Click Save (you can use “Save As” to save the above as a template)  
 
 

Ensonic PARIS OMF 
Export:  Failed or garbled PARIS OMFs can often be traced to corrupt audio files. 
Fix; If you have access to the original PPJ, rebuild that and any other suspicious files from inside 
the PARIS app: select "Duplicate file" and when complete use "reset file path" to change 
references from the old to the new. Performing a dummy "convert sample rate" on the audio file will 
also recreate a fresh header: leave the quality on "highest" and set the output sample rate the 
same as the input; the "dummy conversion" leaves you with a virtually identical file with a fresh 
header; use "reset file path" to change the old file's reference to use these new files. 
Export: "illegal" characters in filenames, PARIS allows you to name things  (or even named them 
itself) in such a way that it can no longer export them correctly!   
Fix: Don’t use Illegal characters like \ or / in either Audio file names or in “track names” (PARIS 
uses track names while rendering). If necessary, delete names of problematic segments in the 
Audio Bin (PARIS' OMF exports can choke on the "/ slash" that PARIS inserts to separate file and 
segment names). To delete the names of segments in the Audio Window, right-click the name of 
the segment (not the "file"!) and hit "backspace".   
Thanks to KerryGalloway for testing AATranslator with PARIS, see 
http://www.kerrygalloway.com/WikiPARIS/  for more Paris related info.  

Final Cut Pro OMF (Apple) 
Exports will have the following characteristics:-  
Only audio will be exported.  
All FCP OMF’s are of the embedded type (IE the audio & session data are in one file) this file can be a 
maximum of 2gig-Bytes. 
All fades are exported as linear type.   
Any disabled audio tracks (Track Visibility control turned off) will not be exported.  Disabled audio 
clips are also ignored. 
Speed change and reverse-speed effects will be rendered to new files.  
Nested sequences will be combined and exported as a single sequence. 
Audio filters (FCP jargon, for plug-ins) are ignored. 
Level and pan information is exported. 
 
To export audio from a sequence as OMF. 
1 Select a sequence in the Browser or open a sequence in the Timeline. 
2 In the Timeline, make sure that each audio track you want to export is enabled (make sure the 
track Visibility control next to the track is green). 
3 Choose File > Export > Audio to OMF. 
4 You will then see the “OMF Audio Export” box 
Select the sample rate & the Bit depth to be the same as your source material. (Or the highest 
resolution source material if mixed rates are used). 
Sound editors want “Handles” (extra material beyond the In/Out points chosen by the picture 
editor), choose 1sec minimum. If in doubt ask the person you are sending your sound to. 
The same advice applies to “Include X-fades”, “Level” and “Pan”. If in doubt tick all 3 “tick boxes” 
AATranslator understands all these data types. (But not all destination formats do). 
Then click OK, navigate to where you want to save your OMF, enter a name and click “save”. 

Lightworks OMF 
Video: there are references to the video clips used in a Lightworks session in their OMF’s, but 
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video is always external to the OMF, even if the audio is embedded. On a conversion we show the 
video clips as empty sections but show the names of the video files that were used originally. 
 
Limitations: Lightworks is one of very few programs that can create OMF’s with Multi-channel or Poly audio 
files, AATranslator has limited support for audio files with more than 2 channel  (aka Stereo) files, Eg a 
conversion to  Reaper RPP using Poly files  is fine. AATranslator is developing fast, so this may change in 
days/months rather than years – depending on user feedback.  But for  AATranslator v 3.4 please convert 
Lightworks Poly files to either Stereo or Mono before conversion.  

Premiere Pro CS4 & 5 (Adobe) OMF {export only} 
Export; select a sequence, File > Export > Export to OMF 
In the “settings dialog”; type in a Title, and set sample & Bit rate (see below). 
 
File menu; allows you to make an Embedded or a Referenced OMF, called “Encapsulated” & 
“Separate Audio” . Either is fine for AATranslator suggest, you choose  “Encapsulated”. 
Render menu; suggest “Copy Complete Audio Files” 
 
Note Adobe have concentrated on producing an OMF that is accepted by Protools Digitranslator 2. 
All audio files will be either 16 or 24bit (as you set in the settings dialogue) and there will be a 
constant sample rate. 
The OMF is sample not video frame based. 
Stereo & multi-channel files are converted to mono files. 
Clip gain & volume envelopes are exported for Mono or Stereo audio, for 5.1 to 16chan poly files 
the clip gain of the 1st (Left) chan only is used for all channels, volume envelopes are not exported.  
Clip pan is exported but not Envelopes. Track based automation in a Premiere Pro session is not 
exported. 
Any tracks with the output turned off will not be included in the OMF. 
Mute & Solo settings are ignored. 
 
 
Sonar OMF (Cakewalk Roland) 
Export; File > Export > OMF 
From “Export OMF” dialogue:-  
Save as type; OMF 2 
Audio Packaging; suggest you choose “Embed Audio Within OMF” 
Split Stereo Tracks to Dual Mono; if you intend to convert to mono-centric formats like PT, Open 
TL or ADL select this option.  Sonar is one of a few Daw’s that can use stereo files in an OMF, 
AATranslator cannot currently use its’ split stereo to mono function when a Sonar omf is the 
source. 
Fades & X-fades will be rendered. No volume or Pan info exported. 

Steinberg OMF 
The Export options, Nuendo & Cubase vers 3 & later. File > Export > OMF 
 

 
Suggest you click “Select All”. Exporting only some of the tracks is known to give errors on 
occasion. Exporting the range between markers is fine however. 
OMF Version : choose V2 
 
Export all to one File; this is more commonly called “Embedded”, this is probably the best option.  
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Export Media File References; commonly called “Referenced” 
Either choice is fine for AATranslator, bear in mind no OMF or part of it, in the case of Referenced 
OMF’s, can be greater than 2 gBytes.  

 
Export Clip Based Volume; 
Use Fade Curves; 
Yes to both (note pan info is not exported) 
 
Important Don’t select, Export Clip Names 
 
Export Sample Size; Cubendo generally uses 
32bit float. But if PT is your likely destination 
format you will have to reduce this to 24 bit 
Integer.  
 
Quantize Events to Frames; don’t use 
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Open TL 
Tascam format, used with the MX2424 HD recorder and a number of DAWs Eg Logic & Nuendo. 
 
Converting From Open TL

 
[1] Select drive & folder containing the TL project you want to convert From  
[2] Import from…. “TL” 
All other options set as required for your destination format 
 
Converting To Open TL 
As soon as you select “Export to…” Open TL, the only options you may have to set are those you 
can see in the picture below.  

FPS: Film/Video Frames Per Second; Used when this information is not 
in the Source file IE. Audition XML, Steinberg Track Archive XML, 
Capture, Adobe SES, Samplitude EDL, CMX-EDL, Vegas TXT, or 
Ardour. 
Sample Rate: Used when Source is Tracktion, CMX or Vegas Txt format. 
Bit Depth: Needs to be set when Source format is Audition XML, 
Steinberg Track Archive XML, Capture, Adobe/Syntrillium SES, 
Samplitude EDL, CMX EDL, Vegas TXT, Tracktion, or Ardour. 
Generate File Copies; Files will always be copied for TL Exports (which 
is why the option is greyed out but is “ticked”).  
Convert Stereo To Mono; The TL standard specifies Mono tracks only, 
so for a fully compliant Open TL file select “Convert Stereo To Mono” 
 

However, an “Illegal” TL, containing stereo files can be understood by AATranslator, SSL 
ProConvert & also Logic. And Nuendo too but stereo files are placed on Mono tracks. (To cure 
this, just create new blank Stereo Tracks. Drag an entire tracks worth of “Stereo files on a Mono 
Track” to a blank Stereo track) 
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Overwrite Existing Files; By default when copies of Audio files are made, as is essential for the 
TL format, AATranslator doesn’t waste time overwriting what is already there. This option 
changes that and allows you replace the files on disk with new copies. Note; only applies to 
Audio files, the .TL & Track files will always be updated/overwritten if they already exist in the 
chosen location. 

 A folder will be created having the name of your source session but with –
AATcvTL appended to the end. The location will as always be the “Send output to..” location.  
Within that folder will be copies of Audio Files & Track files as per the special TL folder structure.  
If you want a TL file (& supporting files) to be usable on a Tascam MX2424 HD recorder, aspects 
like what Disk & Audio format you use is critical. Unlike swapping disks between a Mac & PC, or 
easier still via a Network. 
A disk you attach to an Open TL capable machine such as the Tascam MX2424. must:--- 
Use either Wav or SDII files; we only write WAV. The data needs to be written to a FAT32 
formatted disk when using Wav files. If you have a session using SD2 files on a MX2424 you can 
attach a FAT32 formatted disk and use “Smart Copy” to copy the session to have WAV files. 
You must write a fully “legal” Open TL file. Ie only mono files and all having the same bit rate as 
specified in the .TL file. 
 

 



It is vital you read these notes before using CMX-edl. 
Note v3.4 of AATranslator converts Audio events only from cmx, all video events are ignored.  
 
CMX.EDL formats come from the era of Video Tape Editing. 
At their most basic they contain a list of events 
event roll track(s) transition Timecode of Source In/Out & Destination In/Out 
001    JAZYWA   AA/V         C        01:02:30:02 01:02:30:17 01:00:00:00 01:00:00:15 
 
The above means the 1st event “001” is from a “roll” called JAZYWA”, these days this may well be 
a notional roll, bin or possibly a file rather than a roll of videotape. “AA/V” means audio track 1&2 
and the one video track is used, “C” means there is a cut (butt edit) to the next event. 
There is the possibility of so called comments that were originally just human readable information 
but now contain sometimes highly manufacturer specific info. And other info that is readable by 
others including AATranslator. 
Some examples (from Final Cut Pro v7) 
* EFFECT NAME: CROSS FADE (+3DB) 
* FROM CLIP NAME:  IMPACT METAL HIT REVERB 01.CAF 
* COMMENT: 
* AUDIO LEVEL AT 00:00:00:00 IS -4.00 DB  (REEL AX A2) 
* PROBLEM WITH EDIT: CLIP HAD NO TIMECODE TRACK. 
* AUDIO LEVEL AT 00:00:00:00 IS -4.00 DB  (REEL AX A3) 
AUD   3 
Of the above  
The CLIP NAME & the fact this is a mono clip on track A3 is used by AATranslator. 
 
Note for the clip information to be useful it is important the file name is exported and not the clip 
name. (more NLE specific info below) 
 
As well as reading the most popular cmx format, CMX3600, AATranslator can read cmx 340, 3400 
and also Grass Valley GVG4 & GVG_7.  Sony5000 and ACE_25 can be read but the clip info will 
be incorrect. 
 
Where there is no “clip” info as in the example below,  
AATranslator will create “virtual clips, consisting of the “roll” name/number & the start time code. 
TITLE: 017 BREEL1 
FCM: NON-DROP FRAME 
001  BULWARSK AA/V  C        06:38:04:09 06:38:10:05 01:00:00:00 01:00:05:21   
002  BULWARSK AA/V  C        06:38:11:06 06:38:14:08 01:00:05:21 01:00:08:23   
   
So for the example above event 1 = BULWARSK_06.38.04.09 
You can save a Tab Delimited Txt file by clicking on this button in the Media Tab. 

 This can be printed out or used in a spreadsheet for some advanced 
data wrangling.  
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Options you need to set where cmx-edl is your Source format 
Note very rarely cmx EDL’s will have a 
.CMX file ext.  
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Select drive and 
folder containing 
the CMX EDL. 

If so you will have to rename the file (Eg in 
Windows Explorer) to have a .EDL file 
extension. 

 
Select EDL tab on 
“Import from …”   

You must supply this info. Note for either 29.97 DF or ND select 29.97. 
For the rare 30fps Drop format choose 30.    See “Frames per Second 
help” below  

You must supply this info. 
 

Suggestion; make copies if sending a conversion to someone else 
Don't if you just want to swap between programs on the one machine 

 Convert stereo Wav files to dual mono is selected automatically if 
destination session is PT5 (& you have Generate File Copies On).  
It’s an option if going to Open TL, Sam-EDL or ADL. 
 option to replace the media files on disk with new copies. 

 
Frames per Second help 
CMX EDL’s are plain text and are “Human Readable” but they do vary considerably in their layout. 
They may contain “FCM: xxx” as below, that shows the use or not of DF counting & (very rarely) 
the fps used.  
FCM: NON-DROP FRAME 
FCM: DROP FRAME 
FCM: NON-DROP 24 FRAME 
 
The In / Out points will be written like this 
00:00:00:00 (Hours:Min:Sec:Frames) 
Or possibly 
00:00:00;00  
The use of a semi-colon, not colon before the frames quantity (or throughout the timecode number) 
is a way to indicate drop frame counting is in use.  
Note Drop frame almost certainly means a frame rate of 29.97. Rarely it may be used with 30fps, but many 
Daw’s & NLE’s Eg FCP, don’t support 30d.   
All other fps rates are Non-Drop. Very rarely the actual fps rate maybe viewable in the EDL.  
 
 
Limitations 
EDL’s using Drop Frame counting; We do not support DF counting (and many EDL’s are 
incorrectly written in this respect, too) but if you choose the correct fps rate all clips will start at the 
correct time & start at  the correct position on the Timeline. However the out points may be a frame 
or so later than intended. 
Some EDL’s contain multiple FCM entries. A single 29.97fps entry will be accurate for the clip 
starts, but for ND material, the out points may be a frame or so later than intended. 
 
 
 

 



Exporting from FCP 
EDL Title; suggest you indicate which audio tracks you 
are exporting 

 suggest you indicate which audio tracks you 
are exporting 
Format; CMX3600 Format; CMX3600 
Sorting; Master, Audio Merged Sorting; Master, Audio Merged 
Target Video Track Only (v1); [tick] Target Video Track Only (v1); [tick] 
Omit Transitions; [tick] Omit Transitions; [tick] 
Video events are not used, but  this will lessen the size of the 
edl 
Video events are not used, but  this will lessen the size of the 
edl 
Reel Conflicts; Generic Edits  Reel Conflicts; Generic Edits  
EDL Notes; Select File Names [& tick] IMPORTANT the 
other option here is clip names which is of no use! 
EDL Notes; Select File Names [& tick] IMPORTANT the 
other option here is clip names which is of no use! 
Un tick all other “notes” options Un tick all other “notes” options 
Master; leave as set by FCP sequence Master; leave as set by FCP sequence 
Audio Mapping; a cmx3600 edl can only have 4 audio 
tracks. This option allows you to select which of the 
possible 99 tracks on your FCP edit are export. Note 
you can merge 2 or more FCP tracks to a single EDL 
track. You can also set any FCP track to None, which 
allows you to make multiple EDL’s each containing 4 
tracks at a time. You would modify the “EDL Title” so 
you know which EDL has what original tracks on it. 

Audio Mapping; a cmx3600 edl can only have 4 audio 
tracks. This option allows you to select which of the 
possible 99 tracks on your FCP edit are export. Note 
you can merge 2 or more FCP tracks to a single EDL 
track. You can also set any FCP track to None, which 
allows you to make multiple EDL’s each containing 4 
tracks at a time. You would modify the “EDL Title” so 
you know which EDL has what original tracks on it. 
  

Media files in FCP may well be QuickTime MOV’s. AATranslator does not currently extract audio 
from Mov files so either you must use a DAW/NLE that can extract audio from a mov, or use an 
external program like Apple Quicktime Pro. 

Media files in FCP may well be QuickTime MOV’s. AATranslator does not currently extract audio 
from Mov files so either you must use a DAW/NLE that can extract audio from a mov, or use an 
external program like Apple Quicktime Pro. 
  
Premiere Pro (tested with v1.5 & CS3) stores the file names with file ext Premiere Pro (tested with v1.5 & CS3) stores the file names with file ext 
  
Sony Vegas (vers 9) comes with an EDL export script but it is limited to 29.97df or 24fps nd & only 
exports 1video & 1 audio event. And rather annoyingly the file ext is dropped. If there is any 
interest I'm sure we could provide a better featured script. 

Sony Vegas (vers 9) comes with an EDL export script but it is limited to 29.97df or 24fps nd & only 
exports 1video & 1 audio event. And rather annoyingly the file ext is dropped. If there is any 
interest I'm sure we could provide a better featured script. 
  

XML Session Files XML Session Files 
The file extension XML is very widely used; for Session/Project files but also a whole mass of other 
audio & non-audio related duties.   
The file extension XML is very widely used; for Session/Project files but also a whole mass of other 
audio & non-audio related duties.   
AATranslator version 3.4 can read and write 6 distinct types of XML based session files. And read 
Mackie .tracktion files 
AATranslator version 3.4 can read and write 6 distinct types of XML based session files. And read 
Mackie .tracktion files 
When writing a new session file, the letters shown in the next column 
are added to the original file name   →  
When writing a new session file, the letters shown in the next column 
are added to the original file name   →  

Added to 
original 
file name 

Added to 
original 
file name 

Steinberg "Track Archives" from Nuendo or Cubase (also PreSonus) -AAT-S 
Adobe Audition v3 XML session files -AAT-A 

-AAT-V Sony Vegas XML; we can both read & write the less well featured Sony Vegas 
TXT EDL format too 
PreSonus Capture & Studio One -AAT-C 
Apple FCP and Logic Pro (also Pyramix & Adobe Premier CS4 &5) -AAT-F 
Ardour, Harrison X-dubber, Indamixx -AAT-R 

XML Steinberg Track Archive 
Note a Steinberg track archive is called “Selected Tracks” in the Cubendo Export menu & “Track 
Archive” in the Import menu. 
 
Export; Select required Audio tracks and Video track. F
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ile > Export > Selected Tracks. Note do not 
select any Group, MIDI or the Marker track (it’s not included in an export).  
  

 



Important; Any audio “parts” must be converted to “events” 
Select all (Ctrl A on a PC) - A
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udio > Dissolve parts. 
 
MIDI can be contained within a track archive but is not supported by AATranslator.  
Do a separate export of MIDI data to the particular needs of your destination DAW. 
  
Import; Track Archives must be added to an open Project, this can be an existing one, IE you can 
append to a Project, or you can add an Archive to a blank project. It is important you choose the 
correct Project Sample Rate, otherwise events will play at the wrong speed!  
To import; File > Import > Track Archive  

XML Audition v3 
Export; Go to File > Save session as and choose XML. Note if your
source audio is scattered all over your Hard Disks it may be a 
good idea to use the “Save copies” option

 

 too.  
AA XML is a native format, so contains all the considerable 

amount of information that is in an Audition Session. 

XML Sony Vegas Script 
There are 2 script files, which are copied to the folder where you installed AATranslator. 
Eg  
c:\Program Files\Suite Spot Studios\AATranslator\Export AATranslator XML.cs 
c:\Program Files\Suite Spot Studios\AATranslator\Import AATranslator XML.cs.  
 
They need to be copied to your Vegas program  
Eg if using Vegas Pro 9.0 & a normal install "C:\ProgramFiles\Sony\Vegas Pro 9.0\Script Menu"  
These AATranslator scripts enhance the existing standard scripts by adding track gain & track pan 
to the import & export functions.  
 
Not at all obvious; to Import or Export Vegas XML’s, go to  
'Tools', then 'Scripting' in the Vegas menu bar. 
 
Export; Tools > Scripting >Export AATranslator XML 
Import; Tools > Scripting >Import AATranslator XML 
Or 
If you haven’t added our scripts 
Export; Tools > Scripting >Export XML 
Import; Tools > Scripting >Import XML 
Will work, but with no track volume or track pan 
 

XML Apple Final Cut Pro 
Export from FCP; File > Export > XML (then OK)  
If the suggested name is not to your liking Eg “Untitled” give it a sensible name. 
You will have the option to save in various versions of “Apple XML Interchange Format, version n”. 
AATranslator can (we believe) convert from any format from 1 till 5, though version 1 is 
recommended and will contain all that is required.  
Note currently we only support a Project containing a single “Sequence” not projects made up of 
multiple or “ nested” sequences 
 
Import;  File > Import > XML (ok)  This will use the default options which are probably the best 
choice. 
Import options  
Format:  default option is to “Create New Project”, you can also append to any already open 
project via the “Destination” box.  
The “Settings” box will show your FCP default setting, best leave this as is, unless you know the 

 



video file(s) in an AATranslator export has different attributes. 
Options: again the default settings should be fine. Consult your FCP documentation if you want to 
do fancy stuff like linking to Hi-Res video files rather than a rendered QT Movie the sound 
designers used. Hint for this untick “include sequence settings” 
 
You may get a “Warning: Non-critical errors” message, they’re not critical so just ignore them.  
Note AATranslator exports in vers 1 format so is (or should be) acceptable to all versions of FCP.   
 
Tip: if the media is shown as “offline” you can use the function “Reconnect Media” to re-link the 
files to where you have them on your Mac.  
 
Export fromLogic Pro; Choose File > Export > Project to Final Cut Pro/XML. 
Note: Audio Instrument tracks will be bounced to audio files. MIDI tracks are ignored, each track 
will be rendered with Fades and X-fades to a single stereo or mono file as appropriate. 
 
Import;  to Logic Pro (7 to 9) 
File > Import, then choose the file in the Import dialogue 
Or select XML file in the Browser, then click Open.  
 

These 2 File formats are XML based but don’t use the .XML file extension 

PreSonus Capture & Studio One (.capture) 
AATranslator can read & write the native format for PreSonus Capture. Though it is a type of XML 
file it has a .capture file extension. The .capture format can also be read by PreSonus Studio One.  
Files generated by AATranslator have “-AAT-C.capture” appended to the source file name. 

.Adour Format 
Ardour use an XML based native format, this time with a .ardour file extension. 
Ardour files generated by AATranslator have “-AAT-R.ardour” appended to the source file name. 
For more details of the Ardour DAW for Linux & Mac OSX, see http://ardour.org. Note 
AATranslator works perfectly in WINE (Crossover pro 9 and WINE 1.2 that is packaged with 
Ubuntu. It should run fine on any recent version of WINE for OSX as well.  
 
Features currently supported 
-Tracks and regions, placed exactly as they were in the original session. 
-Gain 
-Pan 
-Envelope Gain automation 
-track pan automation 
-fades in and out 
-Crossfades 
Thanks to Peter Celentano for exhaustive testing of AATranslator’s Ardour functions.   
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General Considerations for maximum compatibility. 
There are basic and fundamental differences in the way different DAW’s and Video editors (NLE’s) 
work. Native formats (Eg Reaper’s RPP & Audition’s SES & XML) tend to be well defined and 
predictable, at the other extreme OMF has huge differences between different manufacturer’s 
implementations and even just different versions from the same maker. We have managed to trap 
a large number of these differences but see later for more detailed info to help you understand the 
issues involved. 

“Illegal” characters in filenames 
In practice you are only likely to have characters not be accepted when converting between files 
made using different operating systems or an interchange format like OMF that has very differing 
implementations between versions. 
Eg apart from an OMF made in PARIS that can have a “/” in a name (a mistake on their part) it is 
unlikely any Mac or PC DAW will allow you to have a  / in a filename and if a filename is derived 
from a track name like “B/voc”, the “/” will likely be auto-replaced with an underscore “_”.  
But it can happen.  
The ultra high compatible naming approach, which should not be necessary in most cases, is to 
just use  a-z 0-9 _  with no spaces, a mixture of upper & lowercase is fine and should make for 
better readability.  
/ : \ should be avoided at all times (they are basic to Mac OS 9, OSX and Windows)  
 
If you have difficulties going to or from Apple XML or OMF it is further recommended you avoid [ ] { 
} . , (  ) | < > ! * ? ; “ ‘ & ^ #  and  the space char. Note the Dot . char will as always be used to 
separate the name from it’s extension but other than that use should also be avoided.  
 
Some OMF’s can have a wide range of acceptable characters including spaces others will use 
what are called “escaped characters”. Eg a space will be coded as %20% and it is often far from 
clear what system or mixture of systems are in use.  
The sure way to get round these particular issues is to use the ultra high compatible naming 
approach. With probably the ( ) -  and . being ok too.  
 
It is generally advised to do some tests particularly if going between a NLE from Avid or Apple and 
a DAW.  And is absolutely vital if using OMF. 
 
Stereo files 
There are two approaches when it comes to dealing with two channel or stereo recordings. 
1)      Interleaved; the Left & Right channels become one WAV file (or AIFF, WMA, MP3 etc)  
 
2)    Dual mono; the L&R channels are two separate mono recordings.  
With some cleverness it is quite practical to bind or link these within a DAW so they behave like an 
interleaved file.   
Eg a cut, will cut both channels & a fade will be applied to both the L&R halves & the two halves 
stay in phase. This can be extended to surround formats too.  An advantage is the basic audio file 
is always mono. 
 
A disadvantage is common media players such as Quicktime & Windows Media Player can’t 
handle this format.  Also whilst all DAWs can use mono files, having stereo as two mono files can 
compromise operations on many DAWs. (or more succinctly, be a PITA) 
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The 16 formats AATranslator V3.4 can handle 
** It's quite possible to have an ADL with 
interleaved stereo or even multi-channel 
audio but the way this ADL will be 
interpreted will be very dependent on the 
host DAW. Most assume mono files are 
used. 

XML Audition V3 Stereo Interleaved 
XML Vegas  Stereo Interleaved 
XML FinalCutPro Stereo Interleaved 
XML Steinberg Stereo Interleaved 
XML PreSonus Stereo Interleaved 
ADL AES-31 Mono bar Nuendo/Wavelab which 

uses Stereo Interleaved ** 
The safest option is to convert all stereo files 
to 2xmono L&R files.   

EDL Samplitude Stereo Interleaved  
EDL CMX3600 Mono, Stereo or Poly The same is even more true for OMF files, 

which have huge variations between one 
implementation and another. 

RPP Reaper Stereo Interleaved 
TL Open TL Mono {but “illegal” TL files with 

Stereo audio can be used 
sometimes –see below}  

 
There are a few methods used to indicate 2 
mono files are in reality a stereo pair.  TXT Vegas EDL Stereo Interleaved 
Pro Tools (generally)adds .L or .R to a file 
name 

PT5 ProTools v5 Mono 
SES CEP/Audition Stereo Interleaved Eg if a stereo file called Drum.wav is 

imported into PT, 2 files called Drum.L.wav & 
Drum.R.wav are created.  

 Ardour Stereo Interleaved 
 Tracktion Stereo Interleaved 
OMF
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The AATranslator Copy & split function uses 
the same method (or Syntax).  
Avid use filename_L.wav, and there several 

other methods in use.  

 Stereo Interleaved possible but not 
recommended or commonly used. Poly files not 
unknown (eg Lightworks) 

 
If the coding syntax is understood by the host DAW or NLE; It becomes possible to audition files in 
stereo and easy to place both files together on a Stereo track.   
 
Otherwise they are just regarded as any other mono files.  It is generally possible create empty 
stereo tracks & place the appropriate L&R files in them, but this can be very laborious.   
Because of this it is recommended that if possible splitting is done on the Mono centric machine, 
before a conversion to another format is done. 
 
Multi-channel or Poly Audio files 
Note the following naming will be used when referring to a single audio file 
Mono; 1 audio “channel” or track. 
Stereo; 2 channels of audio, also called Interleaved Stereo, or by others, may be called a 2 
channel Poly. 
Poly; (polyphonic) more than 2 channels of audio in a single file. Also known as Multi-track or multi-
channel. 
 
Sony Vegas  
Audio tracks can contain mono, stereo or poly files but these can be displayed & used as though 
they were mono or stereo tracks (poly tracks too but this is V unusual). The either mono or stereo 
and perhaps “virtual” “source files” can be sent to either a Stereo or “5.1” output buss/mix.  
 
Reaper 
Audio tracks can contain mono, stereo or poly files (up to 64 chan). Stereo & Poly files can be 
“exploded” which will create a “folder” containing n Mono tracks/virtual files. It is also possible to 
“Implode” a selection of tracks to a poly.  
 
A Vegas XML or EDL (.TXT) file imported into Reaper will ignore any channel selection done in the 
Vegas session. Eg if in a Vegas session, chan 1&2 of a 6 chan wav, were selected to be track 1, in 
Reaper all 6 channels would be in track 1.  

 



 
Audition can handle a session with poly files, it will split them into n’ mono channels. 
 
Track types 
DAWs that use only mono files will place these in highly specific track type “wrappers”.  Mono, 
Stereo, 3track LCR, 4 track LCRS, 4 track L&R front + L&R Rear, etc.  ProTools does this and it 
works well. 
 
At the other extreme Reaper has NO track types at all.  Any data can go on a track, Mono, Stereo 
or multi-channel audio, MIDI or Video. You can mix data types on one track if you wish. 
  
Audition v3 is almost as liberal as this.  It can have a mixture of mono and stereo files on one 
track.  And has four track types, Audio, Video, MIDI and Busses. 
 
Sony Vegas has a very flexible way of dealing with mono/stereo file issues.  
 
Two channel or stereo files stay as interleaved files and when imported into the timeline behave as 
a linked/grouped stereo pair, placed on a pair of tracks.  
But L&R can be un-linked and then treated as though they are 2 separate (mono) files.  
 
The way AATranslator deals with this, when converting to other formats is;  
the underlying stereo file will appear twice, on the 2 “tracks” as named in Vegas. So, you will see 2 
stereo tracks on destination formats that have this possibility.  
 
If the destination format allows track panning, the 2 tracks will be panned hard L&R, thus playing 
only the left or right info. IE it will play exactly as per the Vegas original.  
 
As in the above example, only either the L or R channel is used, with many DAW’s it’s V easy to 
convert or just display/use part of a stereo file as mono. 
 
Vegas allows different level, pan & fades on each (mono) half of a stereo file, and this will also be 
read & applied to an AATranslator conversions. 
.   
For mono-centric formats like PT or wherever tracks are “split” during export, what started as a 
single stereo “Vegas” track will become 4 mono tracks.  
 
Sorry, but when converting to some formats there may be duplicated tracks/info – please 
Mute/Delete what is not wanted. [We would far rather have unwanted duplication than any 
omissions]. 
 
 
 
Nuendo, Stereo files & the AES31 format 
There is a special use of the AES31, ADL that Steinberg use to enable stereo files to remain 
interleaved. 
The SSL Pro Convert program also uses the same method for handling stereo files for an AES-31 
export.  IE it can’t export standard ADL’s.  
Otherwise I’m not aware of any programs that use this syntax, any corrections/additions/knowledge 
is most certainly welcome, though. 
 
AATranslator can recognize this method too, so unlike most programs and DAW’s it will 
understand if there are Interleaved Stereo files in a “Nuendo” ADL. So you can use the “Safe” high 
compatibility AATranslator option of converting all Stereo wav files to Mono if you wish. This 
includes using AATranslator to do a Nuendo ADL to Standard ADL conversion. 
Note AATranslator can only split PCM wav files. 
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It is possible with some workflows to…. 

 



Keep these Stereo Files Interleaved 
 

If you started with a Nuendo session like this:- 
Two Stereo tracks with Stereo files 
Tr1 Body  Stereo File on a stereo track 
Tr2 Body2   Stereo File on a stereo track 

The tracklist inside of an ADL exported from Nuendo (or SSL 
Pro Convert) would look like this Neuendo ADL  

Tr1 Body-L     
Tr2 Body-R     
Tr3 Body2-L     
Tr4 Body2-R   
If you convert this “Nuendo” ADL using, AATranslator set to:- “Convert Stereo To Mono” = OFF 
The result is: 

So due largely to the fact that Reaper, 
Audition, Vegas and Samplitude, etc are 
equally happy with a stereo as against a 
mono WAV, on a track, this works well.  

track To AA-XML, EDL or RPP 
output Track names 

Result in Audition,  
Samplitude or 
Reaper etc 

1 
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The names may look a bit odd and there are 
some blank tracks to delete though. 
 

Not quite so ideal, but usable 
An ADL created using AATranslator from any source format using Stereo Interleaved files, [and 
NOT using the “Safe” option of converting all Stereo files to Mono], will seem to load well in 
Nuendo.  
But:~ 
Stereo files will be placed on mono tracks. This can be resolved (or cured) by copying or moving 
{Eg copy-paste onto a set of initially blank stereo tracks.   
A better option here maybe to use Steinberg XML as your AATranslator export format.   
 
Keeping Stereo Files Interleaved – from TL & OMF originals 
The same idea of Reaper, Audition, Vegas and Samplitude not caring if an audio file is Stereo or 
Mono, can be used with sessions sourced from Open TL or OMF. 
Eg, an “Illegal” TL, containing stereo files can be understood by AATranslator, SSL ProConvert & 
also Logic directly. 
AATranslator used to convert such an “Illegal” TL will work very well if you are converting to 
Reaper, Audition, Vegas or Samplitude, [and be odd or mess-up badly going to some other 
formats].  
 
OMF’s  containing Stereo Interleaved files are rare but as above they can successfully be 
converted to suitable destination formats. 
 
Bit Depth (rate):  
Audition, Samplitude, Reaper, Nuendo, Pyramix, Vegas v9 and others can all use 32bit float files.   
 
A few programs can only deal with a maximum resolution of 24bit. Most DAW’s can handle mixed 
bit rates with no conversion. 
Pro Tools is the only DAW that has to have all files at the same bit rate (either 16 or 24bit) 
 
Ignoring 64bit, which some DAW’s can do, here is a table of the max sample rate used for the16 
formats AATranslator V3.4 can handle  
* Early versions of Vegas were 24bit Integer maximum. The SSL ProConvert program can export in 
Vegas vers 3, to 5, with a maximum of 24bit output. V9 with 32bit float files can be imported and will stay as 

Body-L  Stereo File 
2 Body-R blank track 
3 Body2-L Stereo file 
4 Body2-R blank track 

 



32bit for conversion to other formats. But Export to Vegas will be limited to 24bit.  
 
AATranslator is 32bit capable on Vegas import & Export. But we just extract, convert or reference 
to, what is in the source files, we leave it to the user to determine if what is there is suitable for the 
intended destination format. 
 
ProTools is the only DAW that needs all files to be of the same bit rate, 16 or 24bit integer. Audition 
labels this as 24bit packed int (type1, 24-bit). 
 

 type  Max Bit rate  XML Audition V3 32bit Float ** Logic can handle a maximum of 24 bit Int for a TL 
import. XML Apple FCP 24bit Integer 

XML Vegas  32bit Float * *** It is possible to have OMF files using 32bit audio, but 
these are not common or widely readable by most DAW’s 
or NLE’s. 

XML Steinberg 32bit Float 
Capture 32bit Float Capture 

 XML Ardour 32bit Float 
Truth is 16bit & 24bit integer are the dominant formats, 
eg as used in the most widely used DAW, ProTools. 32bit 
Float type 3 is very widely used too, outside the PT 
world, so may be a good choice for many, all other 32 & 
64bit formats have patchy support. (they have their merits 
but are best avoided for easy interchange) 

ADL AES-31 32bit Float 
EDL Samplitude 32bit Float 
EDL CMX3600 Any, not specified 
RPP Reaper 32bit Float 
TL Open TL 32bit Float ** 
TXT Vegas EDL 32bit Float * 32bit throughout the production phase, then a conversion 

to 24bit for mixing, has a lot to commend it as a workflow; 
particularly if there is a fair bit of modification of the 
source files during the production process.  

PT5 ProTools v5 24bit Integer 
Tracktion 32bit Float Tracktion

SES CEP/Audition 32bit Float 
 
Inside a DAW all signal modification, (DSP, or Digital 

Signal Processing) involves maths, algorithms, which may be quite complex. Inevitably there will 
be “rounding errors”.  [Eg 10 div by 3 = an infinite number!  So in the real world the value will have 
to be rounded, to an approximate value).  Now the more bits you have the smaller will be these 
inevitable errors.  The advantage of seemingly stupidly high bit rates in a DAW is the sum total of 
the quite possibly really huge number of (tiny) errors will not become audible.  There is a good 
augment that for high quality final replay 16bit is pretty near perfection, and anything > 20bits has 
no real, audible advantage at all.  So a 24bit conversion from 32bit production tracks for the final 
mix will contain and maintain all the quality needed.  

OMF Avid OMFI 24bit Integer *** 

IE this is an ideal method for those who (for whatever reasons) choose to use a DAW other than 
ProTools for their tracking, editing, processing work, but need to mix in PT. 
Going the other direction, working in 24bit or far worse 16bit, then bumping up to 32bit to mix, will 
work, but has very little to commend it. 
     
Use PCM WAV files for maximum compatibility 
The “Generate File Copies” option in AATranslator, will copy all the files in your project but will not 
attempt to "understand" any of the files being copied.   
 
AATranslator can split most stereo interleaved wav  files but be aware that Audition is one of the 
few apps that can understand a 20bit Wav and a 16.8bit  wav is ONLY understood by Cool Edit 
Pro and Audition. But the good news is, Audition has no problem converting these rare files to a 
more regular 24bit Int format. Note the Batch convert facilities (EV page) in AA make this a simple, 
fast and a very high quality option.  
It is recommended for best compatibility, that all non PCM WAV files, eg AIFF files & MP3's etc, 
are converted to standard WAVs before an export is attempted. This action will get the nearest 
thing to a universally understood conversion that we or anyone else can come up with. 
 
Correcting errors by editing a session file 
Note ADL, EDL and Vegas TXT files can be edited via the File menu and notepad.  
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If you feel like editing any other formats we recommend you open them in a Hex editor.  

Editing an ADL in Notepad (an example, for the brave)  
Clip Mutes & Nuendo V3 and greater 
 
Let us suppose that you may want to mute some clips; for example, for material that may be useful 
in a mix but is to be temporarily silenced. 
In all versions of Nuendo, an AES import with mutes works fine but on Export for V3 or greater any 
muted clips are excluded from the export!  This is a feature that some users like but others don’t. 
It is quite easy using Notepad to remove all the mutes from an ADL.  
 
1) open the ADL in Notepad. 
2) Ctrl H will open the Replace function 
3) type "M" in the find box & "_" in replace box. Do include the quotes, this is most important 
4) click Replace All  
5) Click Save As, enter the name with .ADL at the end and most important select “Save as type” 
“All files” if you don’t it will be the same file but have an inappropriate .TXT extension, not the .ADL 
needed. 
You may want to “Save As” with a revised name.  
 
Note if you are opening an already saved ADL file you can skip stage 5 and just click save, which 
will overwrite the original ADL. 

How to edit an ADL file with a “path” problem 
Eg  changing /E/ to be /E:/   This could unlike "a Selected folder” option cope with files at multiple 
drive locations. 
The section of the ADL where the file paths are stored starts with this:-  
<SOURCE_INDEX>      & ends with  
</SOURCE_INDEX> 
The 1st entry will start with something like this  
(Index)  0001  (F)  "URL:file://localhost/E:/QT Movies/greatest…………….wav” 
if the 2nd entry had a path problem it may look like this 
(Index)  0002  (F)  "URL:file://localhost/e/AATranslator/…wav” 
or this 
(Index)  0002  (F)  "URL:file://localhost/Big_Disk/AATranslator/…wav” 
 
The problem is the Drive or the Disk Partition description.  If there are only a few entries then 
simply editing  /e/ to become /E:/ will work fine. (Either upper or lower case letters can be used here).  
Another problem for some programs (Not AATranslator) is if the “URL:” part is written as url:.  This 
can be corrected by the same methods. 
If there are a lot of entries, use the Replace function in notepad.  Copy paste into the “Find” box at 
the least, /E/ [this will fail if you happened to have a folder called E], so a better method is to 
copy/paste a few more characters, eg “localhost/e/AA”. 
 
Paste the same copied text into the “Replace” box, then edit the replace value to be 
“localhost/e:/AA”  (in this example).  

How to edit a Vegas TXT file containing Video to be compatible with Reaper & SSL 
ProConvert import   
Reaper and SSL ProConvert don't like "VIDEO" as an entry for "MediaType" in a Vegas .txt (EDL) 
file, the video event both sound & picture is ignored. Sony Vegas & AATranslator, however, need 
this entry.  
If the entry ;VIDEO; is changed to ;AUDIO; Reaper will load the video file & extract any sound.  
 
If you look at a Vegas .TXT file as produced by AATranslator (or Vegas) the section to change will 
look like the following 
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"ID";"Track";"StartTime";"Length";"PlayRate";"Locked";"Normalized";"StretchMethod";"Looped";"On
Ruler";"MediaType";"FileName";…….. 
  1;  0;         0.0000;      4320.0000;1.000000;FALSE;FALSE;0;TRUE;FALSE;VIDEO;"D:\JL 
Documents\Family\Wedding\Video AVI vers\43_12Aug 16 19.AVI";….             
  2;  1;         0.0000;      
4320.0000;1.000000;FALSE;FALSE;0;TRUE;FALSE;AUDIO;"E:\AATranslator\StereoWAV\Audio 
for 43_12Aug 16 19.Wav;………….. 
 
Use the “Replace” function in Notepad, enter ;VIDEO; in the find box &  ;AUDIO; in the Replace 
box. Note the semi-colons are vital! 
 

"Clip based" as against time-line based concept. 
In music production, historically speaking, back in the 1970/80’s & just about 1990’s SSL 
automation was the best, surpassing all previous attempts at viable “automation”. As a 24 track 
Analog recorder was then the “state of the art” standard, the automation was strictly "time-Line 
based" as we would think of it in a DAW, ie all changes happen at a particular moment in time.  
And for music this is still just fine a lot of the time. 
 
In a post pro for Film/TV world this makes no/little sense at all.  If you have a "clip" and EQ, level 
change or whatever, to it - it makes more sense that what you have done is retained, so if you 
Copy/Paste to another location it is a good idea the DSP style "instructions" stay attached to the 
clip/region/segment - sure you can change them, but the Clip based approach means by default a 
clip comes with any modifications you have made.  Samplitude call this "Clip based" idea, "Object" 
based editing and is central to their concept.  

 
Most DAWs (well all 
bar Pro Tools) have 
clip-based features 
such as fades, 
gain/loss, Volume & 
Pan envelopes and 
Mutes. One of the 
challenges we have 
faced is converting 
between clip based 
& timeline {aka 
“keyframe”} based 
automation. 
Audition is a good 
example of a clip-
based DAW.  
 
To change Clip 
values in Adobe 
Audition click on a 
clip and type Ctrl H 
(or right mouse 
click). 

Notice how the envelopes (Volume light green and Pan Blue) are not the same as the clip values, 
though in Audition these envelopes are also tied to the clip and not the timeline.  
 
There is in addition entirely timeline based automation tracks as a 3rd means of altering level, pans 
and mutes.  
The clip values are shown on the clip however to let you know what is happening.  As are lock 

www.aatranslator.com.au Page 32
 



status and clip mute status.   
 
When volume values are being modified by use of clip based 
automation the Track volume control behaves as a constant 
trim/boost control to all the clips on that track. Where timeline 
automation is used either on it’s own or in combination with 
clip based automation the Track volume control behaves in the 

same way if no dynamic volume envelopes are written. When track Volume envelopes are written 
the Track volume control will vary to show the level at the cursor position. 
 
 
 
Display issues using Windows 7 (x64)  
Fix: try running AATranslator in XP compatibility mode. 
 
Data, info tables 
Avid NLE’s Partial list 
 
Year  OS Name Ver

sion 
Notes/Major Features 

1989 Macintosh  Avid/1  
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 First Avid. Mac based, becomes Media 
Composer 

1992 Macintosh  Film Composer  First true 24-frame capture, editing, and 
playback system 

1995 Mac OS 7.5  Media Comp 5.5 Last version to run on Macintosh 68K 
hardware 

1999 Mac OS 7.6 to 
8.6  

Media Comp 7.2 Last version on ABVB hardware. 

1999 Mac OS 8.5.1  Media Comp 8 First version based on Meridien hardware. 
Uncompressed SD video. 

1999 Win NT4  Media Comp 9 First Media Composer release on 
Windows NT 4.0 (Meridien) 

2000 WinNT/Mac OS9 Media Comp 10 SD 24p support for Meridien on Mac 
2001 Win2K/Mac OS9  Media Comp 11 Support for Windows 2000 
2002 Win2000 Media Comp 11 Marquee integrated (Windows only) 
Feb-03 Mac OSX  Media Comp 12 First version to support Mac OS X 
May-03 Win2000 

Mac OS X 
Adrenaline 1 First version of Media Composer 

Adrenaline MC 
Nov-03 Win2000 

Mac OS X  
Media Comp 12 Last version of Media Composer on 

Meridien hardware 
Sep-04 WinXP 

Mac OSX 
Adrenaline 1.5 MXF support, Marquee on Mac 
MC 

Dec-04 WinXP  Adrenaline 2 HD support, 10-bit video, SpectraMatte 
keyer, AVX2 MC 

Mar-05 WinXP  Adrenaline 2.1 P2 support, XDCam support 
MC 

Dec-05 WinXP  Adrenaline 2.2 HDV support 
MC 

May-06 Win XP (Mac?) Xpress Pro discontinued 2008 
Jun-06 WinXP 

Mac OSX 
Adrenaline 2.5 HD on Mac, Media Composer soft, Mojo 

and Mojo SDI support, XDCam HD, 
Tracker 

MC 

Sep-06 WinXP 
Mac OSX 

Adrenaline 2.6 Interplay, Color Safe Limiter effect 
MC 

Mar-07  DNxHD36  DNxHD36, low-bandwidth HD 
compression rate for offline editing 
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May-07 WinXP/Mac OS 
X  

Adrenaline 
MC 

2.7 MacPro (Intel) support, ScriptSync, P2 / 
XDCam writeout 

Dec-07 WinXP 
Mac OSX  

Adrenaline 
MC 

2.8 VC-1/MXF (SMPTE 421M) support 

Jun-08 WinXP 
Mac OSX  

Adrenaline 
MC 

3 DX hardware support, new render engine 
(better multi-threading and GPU support), 
RT timecode generator, SubCap effect, 
AVC-I codec support 

Sep-08 WinXP 
Mac OSX  

Adrenaline 
MC 

3.1 XDCAM 50mb format, DNA hardware on 
MacOS 10.5.5, RED workflow support 

Dec-08 WinXP 
Mac OSX  

Adrenaline 
MC 

3.1.1 

Dec-08 WinXP AV Option ? 3.1 Video Satellite option for ProTools (Win 
only) 

Mar-09 WinXP 
Mac OS X  

Adrenaline 
MC 

3.5 Avid Media Access (AMA) for better file 
based workflows, FluidStabilizer, 
Keyframeable Color 

Sep-09 WinXP 
Mac OSX  

Adrenaline 
MC 

4 Mix and Match frame rates on timeline, 
Expert Decompose, AVC-I writeout, 
Macintosh Video Satellite support, 
1080p24 (not-PsF) output, HD Ancillary 
data support on DX hardware, GFCAM 
50mb/100mb support, Stereoscopic 
enchantments, updated 3rd party software 
bundle 

Jun-10 WinXP  
Mac OSX  

Adrenaline 
MC 

5 AMA support for RED, Quicktime and 
Canon cameras, Matrox MXO2 Mini 
output, New 'drag & drop' editing, HD-RGB 
support, AVCHD import, SMPTE 436M 
support, RTAS audio plug-in support 
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